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Introducción
Bienvenidos a Hitachi Software StarBoard Software 7.1. StarBoard es un monitor de pantalla grande 
para PC y equipos de visualización, que sirve también como pantalla interactiva en la que se puede 
escribir directamente,  o que puede controlarse mediante PC.

Acerca de esta guía
La Guía del usuario de StarBoard Software 7.1 es un tutorial para StarBoard Software 7.1, que es un 
programa de utilidad para StarBoard. 
Esta guía describe procedimientos generales de uso.
Para obtener información acerca de la instalación, consulte la Guía de instalación de StarBoard 
Software. Para obtener más información acerca de las funciones de StarBoard Software, consulte la 
Ayuda en pantalla de StarBoard Software 7.1.
Para obtener información acerca de cómo utilizar StarBoard, consulte la Guía del usuario que se 
incluye.

Requisitos del sistema
Los requisitos mínimos del sistema para utilizar StarBoard Software son los siguientes:
•CPU: Pentium II 300 MHz o más rápido (se recomienda Pentium III 800 MHz)
•Espacio libre en el disco duro: 300 MB o más
•RAM: 128 MB o más (se recomienda 256 MB)
•Colores de pantalla: color de alta densidad (16 bits) o superior
•Sistema operativo (SO): Windows 2000/XP
•Software necesario: Internet Explorer 6.0, PowerPoint 2000/2002/2003, DirectX 9.0b
•Unidad de CD-ROM o DVD
•Otros: tarjeta de vídeo que incluya superposición de hardware (cuando se utilice la función de 

vídeo)
El Pentium 4 1.8 GHz o más y el RAM 512 MB o más se requieren para la característica de la película 
o de la red.

Las funciones y procedimientos de StarBoard Software que se describen en esta guía hacen 
referencia a un ordenador en el que se está ejecutando Windows XP (Service Pack 2).

Renuncia
Hitachi Software Engineering Co., Ltd. no asume ninguna responsabilidad ni ofrece ninguna 
garantía, explícita ni implícita, relativa a la información que se presenta en esta Guía del usuario.
Además, Hitachi Software Engineering no ofrece ninguna garantía respecto a objetivos de uso 
específicos, ni ninguna garantía en absoluto respecto al valor ni al rendimiento del producto.
Todos los productos de Hitachi Software Engineering que se presentan en esta Guía del usuario se 
venden o se ceden bajo licencia según los procedimientos actuales.
Los usuarios que compren los productos mencionados asumirán los gastos derivados de cualquier 
mantenimiento, reparación o daño que se produzca como resultado de los defectos de estos 
productos, así como las pérdidas directas o indirectas (incluidas las pérdidas de beneficios y de 
información necesaria) resultantes de los defectos del producto.
La reproducción o transferencia no autorizada del contenido de este documento, en todo o en parte, 
está prohibida.
El contenido de este manual puede cambiar en un futuro sin previo aviso.
Se han realizado todos los esfuerzos posibles para garantizar la precisión del contenido de este 
documento. No obstante, si descubre cualquier error o cualquier anomalía, notifíquelo por favor al 
distribuidor al que adquirió el producto.
Con independencia de los términos anteriores, Hitachi Software Engineering no asume ninguna 
responsabilidad por ninguna pérdida de datos o circunstancia similar derivada del uso de este 
producto.

Estipulación de garantía del producto
La garantía de este producto está limitada a su uso en su país o estado.

Marcas comerciales
Windows®, PowerPoint, DirectX y Windows™ Media son marcas comerciales registradas de 
Microsoft Corporation en los Estados Unidos o en otros países. LEAD y LEADTOOLS son marcas 
comerciales registradas de LEAD Technologies, Inc.
ritePen, riteForm y EverNote son marcas registradas de EverNote Corporation.
Todas las demás marcas comerciales o marcas comerciales registradas son propiedad de sus 
respectivos propietarios. Además, todos los datos que aparecen en el producto, en los archivos de 
ejemplo y en elementos similares son ficticios, y no guardan ninguna relación con ninguna empresa 
ni persona real.

Reservados todos los derechos. Copyright 2004, 2006, Hitachi Software Engineering Co., Ltd.
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Chapter 1

Página de bienvenida de StarBoard Software

C
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Tanto si desea mostrar una presentación de diapositivas, utilizar la pizarra interactiva, reproducir una 
película o mantener una teleconferencia, todo en StarBoard se inicia desde la página de bienvenida.

Cuatro menús de tareas

Pantalla interactiva
Para abrir archivos tales como 
documentos de Microsoft Office 
(Word, Excel, PowerPoint) y 
archivos de imagen o película.

Teleconferencia
Para mantener una

teleconferencia
(no se describe en esta guía).

Dispositivo de vídeo 
externo
Para mostrar fragmentos de 
película en StarBoard cuando hay 
vídeo digital conectado al 
ordenador.

Pizarra interactiva
Para utilizar las funciones de la
pizarra. Es posible elegir entre
una amplia gama de plantillas

de la biblioteca y entre diversos
tipos de lápiz de color.

Menú Herramienta

1 Principal
Vuelve al menú principal (esta pantalla) 
desde otras pantallas, tales como Datos 
guardados.

2 Datos guardados
Muestra una lista de datos (notas para la 
reunión o para la conferencia) creados 
con StarBoard Software.

3 Favoritos
Muestra una lista de archivos archivados 
previamente como documentos.

4 Configuración
Muestra el menú de configuración de 
StarBoard Software.
[Configuración] contiene los tres 
siguientes submenús.
•ConfLápiz
•Calibrado (consulte la página 19)
•Configuración de opciones
[Configuración de opciones] permite 
configurar las preferencias. Consulte la 
ayuda en pantalla para obtener más 
información sobre cómo cambiar la 
configuración.

5 Ayuda
Muestra la ayuda en pantalla. 
Consulte la ayuda en pantalla para ver 
información sobre usos más avanzados y 
funciones útiles de StarBoard Software. 

6 PC
Cambia a la pantalla del escritorio de su 
ordenador. Es posible controlar el 
ordenador directamente desde StarBoard.

7 Fondo
Cambia la imagen de fondo para el menú 
principal (esta pantalla).

8 Salir
Sale de StarBoard Software.

P.14 P.10

P.7
Chapter 1  Página de bienvenida de StarBoard Software3
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 Chapter 1

Barra de herramientas de 
StarBoard Software

Puede realizar todas las acciones de StarBoard 
mediante la barra de herramientas.
Cuando toque el 
botón StarBoard 
aparecerá el menú. 

Cuando toque el 
menú, aparecerá un 
submenú.

Mode Tool View Edit Network

Documento

Para agregar iconos de uso 
frecuente, arrástrelos desde el menú 
o los submenús y colóquelos en la 
barra de herramientas.
Es útil registrar [Elemento utilizado 
recientemente] en la barra de 
herramientas si se va a ejecutar 
repetidamente una misma función.

Para eliminar un icono 
previamente agregado, 
arrástrelo y colóquelo fuera de 
la barra de herramientas.

Barra de herramientas
(Configuración predeterminada para el modo 
de pizarra)

Es posible agregar a la barra de herramientas elementos de uso frecuente.
Un enfoque útil consiste en configurar las herramientas necesarias (lápiz rojo, plantillas, etc.) antes de la 
presentación o de la teleconferencia.

Configuración

*La barra de herramientas real puede variar en algunas áreas.
 Software 7.1 4
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Chapter 1

Escribir texto en StarBoard El punto de partida para usar StarBoard consiste 
en grabar la información de la pizarra en forma 
de datos digitales.
C
hapter 1
Tres lápices de StarBoard
StarBoard tiene tres lápices diferentes.

Lápiz
Este lápiz puede utilizarse igual que un lápiz corriente. Puede elegir el color y el 
ancho de línea que desee.

Lápiz-puntero láser
El Lápiz-puntero láser funciona como un puntero láser durante las presentaciones 
y las películas.
Puede dibujar libremente líneas sobre la pantalla como con el lápiz. Cada línea 
desaparece cuando se dibuja la siguiente. Por lo tanto, el Lápiz-puntero láser 
resulta adecuado para escritura temporal, y para poner marcas donde desee que se 
centren los espectadores.

Lápiz inteligente
El Lápiz inteligente puede utilizarse para dibujar líneas libremente. Además, las 
formas tales como círculos y cuadrados se ajustan automáticamente. El lápiz 
inteligente incluye funciones inteligentes tales como el desplazamiento de la 
pantalla y la manipulación de objetos.
Consulte la ayuda en pantalla para obtener más información sobre el uso de este 
lápiz.

Indicador de herramienta
Tres iconos de la pantalla [Indicador de 
herramienta] muestran la configuración 
actual de la punta del lápiz y de los dos 
botones del lápiz electrónico.
Puede cambiarlas por otros elementos en el 
menú de herramientas de la barra de 
herramientas de StarBoard, si es necesario.
(Si utiliza una pizarra de tipo F, puede 
establecer la herramienta  Suspensión en 
los botones laterales.)

1 Iniciar StarBoard Software

Seleccione [Inicio] > [(Todos los) 
Programas] > [StarBoard Software] y, a 
continuación, haga clic en [StarBoard 
Software].

2 Seleccione [Pizarra interactiva]

Toque [Pizarra interactiva] en el menú 
principal de StarBoard.

3 Abra la pantalla 
de la pizarra y 
muestre la barra 
de herramientas 
de StarBoard

TOUCH!

Al hacer clic aquí se
minimiza o maximiza

la barra de
herramientas.

Al hacer clic aquí se muestra el
menú de herramientas.

Consulte la página 4 para ver más
información sobre el menú de

herramientas.

Minimizar
Chapter 1  Escribir texto en StarBoard5
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4 Escribir texto con el lápiz de escritura manual
Seleccione [Lápiz] para introducir texto.

Seleccione el lápiz 
de escritura manual 
y escriba a mano en 
la StarBoard.

Si comete un 
error, ...

...seleccione el borrador y 
borre el error.

Lápiz

Borrador

Para borrar todo lo que haya escrito, 
seleccione Borrar. 

HINT!
Seleccione [Edit] > [Deshacer] para 
restaurar el estado de trabajo 
inmediatamente interior. 

5 Cambia el color y el ancho de línea del lápiz
Estas configuraciones de color y ancho de línea del lápiz también se aplicarán la 
siguiente vez que se inicie el programa.

6 Guardar los datos y cerrar el archivo

[Cambiar ancho]
Puede ajustar el ancho de 
línea con la barra 
deslizante.
Hay tres anchos diferentes 
(fino, medio y grueso) 
disponibles.

[Paleta de colores]
Puede seleccionar el color 
que desee para el lápiz.

HINT!
Después de guardar datos, 
seleccionando [Guardar], es 
posible abrirlos mediante la opción 
[Datos guardados] del menú 
principal.

Seleccione [Salir].
Cuando aparezca el cuadro de 
diálogo [Confirmación], si toca 
[Descartar], la pizarra se 
cerrará y se mostrará de nuevo 
el menú principal.
6StarBoard Software 7.1
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Chapter 2

Una presentación eficaz

C

hapter 2
Tomás Hitachi, que trabaja en la oficina de la sucursal, debe ofrecer una 
presentación durante una reunión relacionada con un nuevo negocio, que 
tendrá lugar en la oficina principal.
Tomás creó primero un archivo de PowerPoint en su ordenador, en la oficina 
de la sucursal, y guardó el archivo en un dispositivo de memoria USB.
En la sala de presentaciones de la oficina principal, utilizará un ordenador 
que se usa exclusivamente con StarBoard.

Sucursal

Oficina central

1 Guardar un archivo de PowerPoint en un 
dispositivo de memoria USB
Guardar un archivo de PowerPoint que contiene una presentación de 
diapositivas en un dispositivo de memoria USB.

HINT!
Un dispositivo de memoria USB es un 
dispositivo de grabación que se conecta a 
un puerto USB del ordenador. Una vez que 
el dispositivo se inserta en un puerto USB, 
se indica como "Disco extraíble" en "Mi 
PC". Puede guardar datos en él tal como lo 
hace en un disquete.

Ahora le toca a Tomás ofrecer su presentación.  

2 Conectar un dispositivo de memoria USB a un 
ordenador dedicado a StarBoard 
Chapter 2  Una presentación eficaz7
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3 Iniciar StarBoard Software
Seleccione [Pantalla interactiva] en el menú principal.
Se mostrará un cuadro de diálogo [Pantalla para], que pide que se seleccione el 
tipo de archivo.

HINT!
Cuando se conecta el dispositivo de memoria 
USB al ordenador, aparece un cuadro de diálogo 
con el siguiente mensaje: “?Desea abrir un 
archivo en la memoria USB?”. Seleccione [Sí] 
para mostrar la lista de archivos y carpetas 
guardados en el dispositivo de memoria USB en 
la pantalla del Explorador de Windows.

4 Seleccione [Presentación…]
Abra [Disco extraíble] desde la pantalla de selección de archivos y seleccione el 
archivo guardado en el paso .

5 Iniciar la presentación de diapositivas
La pantalla muestra la diapositiva de título del archivo de PowerPoint.
Cuando se abre un archivo de PowerPoint, los iconos de la barra de tareas 
cambian automáticamente a una combinación adecuada para las 
presentaciones de diapositivas de PowerPoint.

TOUCH!

1

TOUCH!

6 Controlar diapositivas mediante la barra de 
herramientas
Toque [Página Siguiente] para avanzar por las diapositivas.

HINT!
Puede utilizar la función [Foco] (consulte la 
página 19) para mejorar las presentaciones.

Tomás ha vuelto a una diapositiva anterior para mostrar de 
nuevo artículos anteriores.

7 Abrir una diapositiva desde la lista de páginas
Seleccione ([View] >) [Lista de páginas] en la barra de herramientas de StarBoard 
para mostrar la lista de diapositivas de PowerPoint. Ahora puede seleccionar la 
diapositiva que desee y desplazarse fácilmente por las diapositivas.

Tomás ha escrito texto en una diapositiva para complementar su 
presentación.

Double-click 
the slide
8StarBoard Software 7.1
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8 Escribir texto en una diapositiva
Puede escribir texto o dibujar formas directamente en una diapositiva, tal como 
escribiría en una pizarra.

HINT!
Para examinar la configuración del lápiz, 
toque [Indicador de herramienta] en la 
barra de herramientas de StarBoard 
(consulte la página 5). 
De este modo es posible examinar y 
cambiar la configuración de la punta y de 
los botones del lápiz.

Ahora vamos a intentar guardar una presentación de 
diapositivas con notas creadas durante la presentación. 

9 Finalizar una presentación
Guarde ahora, en el disco extraíble, las notas y las diapositivas en las que se 
escribió durante la presentación, en forma de archivo html.

Toque [Lista de páginas].
Seleccione [Guardar] > [Exportar a un 
archivo] en la pantalla [Lista de páginas]. 

Se mostrará la pantalla [Guardar como]. 
Asegúrese de que [Guardar en] esté 
establecido en la unidad extraíble y, a 
continuación, cambie [Tipo] a html y 
toque [Guardar].
Seleccione [Salir] en la barra de 
herramientas de StarBoard. 

Para crear más tarde un informe, recuerde guardar en el 
dispositivo de memoria USB las notas u otros datos de la 
presentación, y llevarse consigo el dispositivo.
9 Chapter 2  Una presentación eficaz
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 Chapter 3

Pizarra interactiva y digital
John Hitachi es el jefe de proyecto para un nuevo producto. 
Ha decidido convocar a los miembros del equipo del proyecto y mantener 
una reunión para planificar la estrategia de ventas del nuevo producto. 1 Inicie StarBoard Software

Seleccione [Pizarra interactiva] en el menú principal.
En la pantalla aparece una página nueva en blanco.

John ha escrito el orden del día de la reunión en StarBoard.

2 Escriba texto con el lápiz
Consulte la página 5 para ver información sobre cómo usar el lápiz.

TOUCH!
 Software 7.1 10
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John ha cambiado de lugar texto escrito anteriormente para 
escribir las diversas opiniones de los miembros del equipo del 
proyecto.
A continuación, ha llevado a un área en blanco los elementos 
que se encuentran a partir del elemento 2.

3 Mover texto
Seleccione [Edit] > [Selección] en la barra de herramientas de StarBoard. El lápiz 
cambia a una punta de flecha. Si se toca el texto escrito, es posible moverlo.

A continuación, el equipo del proyecto discute el programa.
No había más espacio en blanco en la pantalla, así que John la 
ha desplazado.

4 Desplazamiento de la pantalla
Seleccione [Tool] > [Lápiz inteligente] desde la barra de herramientas de 
StarBoard. Si se deja el lápiz inteligente inactivo durante algún tiempo, en 
contacto con la StarBoard, la forma del lápiz cambia a la de una mano. La 
pizarra se desplaza al mover el cursor. 

HINT!
•Es posible desplazar la pantalla seleccionando [View] > [Desplazamiento] en la barra de 

herramientas de StarBoard.
•El intervalo de la página que se muestra actualmente cambia al seleccionar 

[View] > [Desplaz] en la barra de herramientas de StarBoard. Además, es 
posible moverse a cualquier área sólo con tocarla.

•El lápiz inteligente tiene otras funciones útiles, además del desplazamiento. 
Consulte la ayuda en pantalla de StarBoard Software para ver información 
detallada.

John ha abierto una nueva página en blanco y ha insertado 
imágenes prediseñadas en ella.
11 Chapter 3  Pizarra interactiva y digital
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5 Agregar una nueva página en blanco
Seleccione [Documento] > [Nueva página en blanco] en la barra de 
herramientas de StarBoard. Se agregará una nueva página en blanco.

6 Agregar imágenes prediseñadas
Seleccione [Tool] > [Imagen prediseñada] en la barra de herramientas de 
StarBoard.
Se mostrará la pantalla [Paleta de imágenes prediseñadas]. Cuando tenga una 
imagen prediseñada seleccionada, puede mover el lápiz para colocarla en la 
página en blanco.
Seleccione [Selección] y, a continuación, toque la imagen prediseñada con el 
lápiz electrónico. Cuando el puntero cambie a la forma de una mano, puede 
mover la imagen prediseñada. Si toca el  que se muestra junto a la 
imagen prediseñada, aparecerá un menú desplegable. En el menú, puede 
seleccionar elementos tales como “Eliminar”.

Ahora el equipo discutirá el programa futuro. John ha agregado 
una plantilla de papel continuo y ha escrito en ella los planes 
para cada uno de los miembros del equipo.

7 Agregar una plantilla
Seleccione [Documento] > [ Plantilla...] desde la barra de herramientas de 
StarBoard. Se mostrará la pantalla [Agregar plantilla]. Toque [Papel continuo] 
para mostrar varias plantillas de pael continuo.

Después de la reunión, John volvió a la primera página y revisó 
la discusión con sus colegas.
12StarBoard Software 7.1
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8 Lista de páginas
Seleccione [Lista de páginas] desde la barra de herramientas de StarBoard.

John ha imprimido lo que escribió en la StarBoard, y lo ha distribuido 
en forma de documento a todos los participantes en la reunión.

9 Impresión de la pantalla
Seleccione [Lista de páginas] en la barra de herramientas de StarBoard. Toque 
[Imprimir] en la pantalla [Lista de páginas] y, a continuación, seleccione 
[Imprimir todas las paginas]. Las páginas se imprimen en la impresora conectada 
al ordenador que tiene instalado StarBoard Software.

Además, John ha guardado en forma de archivo, para la 
próxima reunión, las notas de la reunión de hoy.

10 Guardar datos
Seleccione [Salir] en la barra de herramientas de StarBoard. Se mostrará el 
cuadro de diálogo de confirmación. Escriba un [Título] y [Propietario] para los 
datos y, a continuación, toque [Guardar]. Para abrir los archivos guardados, 
muestre la lista de datos del menú principal y seleccione en la lista el nombre de 
los datos.

HINT!
También es posible abrir los datos guardados desde [Datos guardados], en la barra de 
herramientas.
13 Chapter 3  Pizarra interactiva y digital
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 Chapter 4

Película - acción y reacción
Roberto Hitachi acaba de volver de un viaje de observación al extranjero. 
Ahora reproducirá el vídeo digital que grabó durante el viaje. 
Es posible reproducir películas digitales en StarBoard.

Compruebe lo siguiente
•Para introducir vídeo externo en el ordenador conectado a la StarBoard se necesita una interfaz (USB, 

IEEE1394, tarjeta de captura de vídeo, etc.).
•La superposición de hardware se activa combinando un dispositivo de entrada de vídeo externo con 

una tarjeta de vídeo.

1 Conecte el vídeo digital al ordenador.
Para obtener información sobre cómo conectar un dispositivo externo, consulte 
el manual que acompaña al dispositivo externo que esté conectando. 

HINT!
También puede abrir el archivo de película para el ordenador. Seleccione [Ecran interactif] > 
[Archivo de película] y, a continuación, abra el archivo de película que desee.

2 Inicie StarBoard Software
Seleccione [Dispositivo de vídeo externo] en el menú principal. Si hay múltiples 
dispositivos externos conectados, se mostrará la pantalla[Seleccionar dispositivo 
de vídeo].
Seleccione el vídeo digital y, a continuación, toque [EntrVídeo].

Controlador de vídeo (nombres y funciones)

TOUCH!

TOUCH!

Maximizar/minimizar

Buscar diapositiva

Volumen
Reprod.

Pausa

Detener

Retroced.

Paso atrás

Reproducción 
por pasos Lento

Avanzar

Zoom para ampliar

Zoom para reducir
Importar en bloc de notas
 Software 7.1 14
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3 Reproducir vídeo 
En la pantalla, además de la barra de herramientas de StarBoard, aparece un 
controlador de vídeo. 
Toque el botón [Reprod.] del controlador de vídeo. 
El vídeo se muestra en la StarBoard.

Uno de los colegas de Roberto le pide que vuelva a reproducir la 
escena actual. 

4 Controlar el vídeo
Haga una pausa en la reproducción de la película y, a continuación, toque 
[Retroced.]. Cuando el vídeo haya retrocedido hasta la escena deseada, toque 
[Lento].

Roberto hace una pausa en la reproducción de la película y le 
agrega un texto explicativo.

Retroced. Lento

5 Escribir texto y dibujar formas sobre el vídeo
Seleccione [Tool] > [Lápiz-puntero láser] desde la barra de herramientas de 
StarBoard.

Cuando se dibuja o se escribe algo con el 
Lápiz-puntero láser, se borra 
automáticamente la siguiente vez que se 
utiliza para dibujar o escribir. Esta función 
resulta muy útil para indicar áreas que se 
desea destacar temporalmente durante una 
explicación.

Para guardar más tarde el texto o los 
dibujos realizados sobre una imagen de 
vídeo, toque  Importar en bloc de 
notas.

El vídeo ha terminado.

6 Finalizar un vídeo
Seleccione [Salir] en la barra de herramientas de StarBoard.
Aparece un cuadro de diálogo, que pregunta si se desea guardar los datos. Para 
guardarlos, escriba un título y un nombre de propietario y, a continuación, toque 
[Guardar]. es posible abrir los datos guardados desde [Datos guardados] 
(consulte la página 13).

Es útil agregar de antemano el Lápiz-puntero 
láser a la barra de herramientas.
15 Chapter 4  Película - acción y reacción
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Chapter 5

Funciones útiles en StarBoard Software

Se guarda la lista de archivos empaquetados. En la lista del paquete se guarda la lista de 
Iniciar Document Packager
Seleccione [Inicio] > [(Todos los) Programas] > [StarBoard Software] y, a continuación, haga clic en 
[Document Packager].
Se mostrará la pantalla [Document Packager].

Guardar una lista de paquete

Toque [Guardar lista] en la pantalla [Document 
Packager].

Document Packager
Posiblemente haya pasado por la experiencia de preguntarse dónde guardó un archivo, o de
ser incapaz de encontrar el archivo que preparó inmediatamente antes de una presentación
o una reunión importante. Con Document Packager, es posible archivar varios archivos,
ubicados en diferentes puntos del ordenador o de la red, como un solo archivo. 
Document Packager permite guardar, mover y abrir los archivos necesarios de forma
rápida y fiable.

Document Packager Lista del paquete
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archivos empaquetados. Es posible actualizar la 
lista del paquete para cambiar los archivos de 
paquete que contiene. Con un ratón, también es 
fácil realizar acciones tales como agregar y 
reemplazar archivos.

Empaquetar documentos

Selección de archivos
Arrastre los iconos que desee y colóquelos en la 
pantalla de Document Packager para agregarlos 
a la lista.

También es posible seleccionar archivos desde 
la pantalla del Explorador de Windows.
Si hace clic en [Agregar], se mostrará la pantalla 
[Abrir archivo]. Seleccione los archivos a 
empaquetar y, a continuación, haga clic en el 
botón [Abrir].

Empaquetar archivos
Una vez seleccionados todos los archivos a 
empaquetar, haga clic en [Paquete].

Especifique la ubicación donde se guardará 
el paquete, y su nombre de archivo.
Cuando haga clic en [Desa], se ejecutará el 
proceso de empaquetamiento de archivos.

Cuando termine el proceso de 
empaquetamiento aparecerá el cuadro de 
diálogo [Salir].

Los archivos empaquetados son archivos 
guardados y comprimidos en formato cab.
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Actualizar archivos empaquetados

Abra un archivo de lista de paquete. Para quitar 
archivos de la lista, arrástrelos y colóquelos 
fuera de la pantalla de Document Packager.

Es posible agregar nuevos archivos 
arrastrándolos y colocándolos en la pantalla de 
Document Packager.

Haga clic en [Guardar lista], en [Editar orden de 
archivos], para sobrescribir y guardar la lista del 
paquete. A continuación, haga clic en [Paquete] 
para sobrescribir y guardar la versión más 
reciente del archivo de paquete.

Abrir un archivo de paquete

Guarde un archivo empaquetado en el 
ordenador de StarBoard. (O conecte al 
ordenador un dispositivo de memoria USB que 
contenga un archivo empaquetado.)
En StarBoard Software, seleccione [Ecran 
interactif] y, a continuación, toque [Paquete de 
documentos].

Toque el archivo que desee.
17
Seleccione [View] > [Lista de temas] desde la 
barra de herramientas de StarBoard. Se mostrará 
la lista de archivos actualmente abiertos.

Toque el nombre en la [Lista de temas] el 
nombre del archivo que desee para abrirlo en 
primer plano.

Instalar Document Packager en el ordenador
El programa Document Packager se cede bajo licencia para su distribución exclusiva a los usuarios 
de StarBoard. 
El archivo de programa de Document Packager (DocumentPackager.exe) se encuentra en la 
carpeta en la que se instala el programa StarBoard Software. 
Para instalar el programa, copie simplemente DocumentPackager.exe y guárdelo en cualquier 
ubicación dentro del ordenador. Haga doble clic en el icono de la copia de 
DocumentPackager.exe para iniciar el programa Document Packager. 
No utilice nunca el programa Document Packager para ningún otro propósito. Tenga en cuenta 
que los problemas derivados del uso de Document Packager no están cubiertos por la garantía. 
Chapter 5  Funciones útiles en StarBoard Software
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Guardar un perfil de usuario

Seleccione [Configuración] > [Perfil de usuario] 
> [Guardar] en la barra de herramientas de 
StarBoard.

Se mostrará la pantalla [guardar perfil]. 
Seleccione un destino para guardar el perfil y, a 
continuación, confirme el nombre del perfil y 
seleccione [Guardar].

Es recomendable especificar nombres de 
perfiles que faciliten la tarea de distinguir su 
propósito en particular o el nombre del usuario.

Perfil de usuario
Puede utilizar perfiles de usuario para guardar configuraciones específicas del usuario,
tales como las barras de herramientas. Una vez que guarde su perfil de usuario, por
ejemplo para presentaciones de diapositivas, podrá cargar rápidamente la
configuración necesaria para la barra de herramientas.
StarBoard Software 7.1 18
Cargar un perfil de usuario

Seleccione [Configuración] > [Perfil de usuario] 
> [Cargar] en la barra de herramientas de 
StarBoard. Seleccione la ubicación del perfil y 
especifique el perfil que desea cargar.
Se cargará el perfil de usuario.

Perfil de usuario

HINT!
Resulta muy útil crear perfiles personalizados para aplicaciones particulares, tales como el uso de 
la pizarra y el uso de presentaciones. 
Si guarda un perfil en un dispositivo de memoria USB, podrá cargar el perfil en otro ordenador. 
De este modo, podrá utilizar StarBoard con la misma configuración de perfil independientemente 
del lugar donde se encuentre.
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Compruebe la conexión con StarBoard 

Comprobar conexión Toque [Comprobar conexión] en el menú 
principal. Compruebe el estado de la conexión 
entre StarBoard y el ordenador. 
El botón [Comprobar conexión] aparecerá en 
rojo si la conexión no es correcta. Compruebe la 
conexión del cable y las demás conexiones.

¿Está colocada de forma incorrecta la pantalla de StarBoard? 

Calibrado Seleccione [Configuración] > [Calibrado] en el 
menú principal.
Se mostrará el cuadro de diálogo [Calibrado].

Si hace clic en [Aceptar], se mostrará la pantalla 
de ubicación del lápiz.

Siga los mensajes de la pantalla para 
tocar con el lápiz el centro del punto 
estándar (marca roja intermitente). 
Una vez completado el calibrado, 
toque [Aceptar] para volver al menú 
principal.

¿Desea mejorar las presentaciones? 

Foco Durante la presentación de un archivo de 
PowerPoint, seleccione [Mode] > [Accesorio] > 
[Foco] en la barra de herramientas.
Se mostrará el foco.

Cuando toque este botón, aparecerá la 
pantalla de configuración del foco. 
La configuración se aplicará hasta la 
próxima vez que se modifique. 
Establézcala antes de iniciar una 
presentación. 
Puede mover la posición del foco con 
el lápiz. 
Toque [Cerrar] para cerrar el foco.

¿Desea grabar el contenido de la reunión? 

Grabación de pantalla Para grabar el contenido de una reunión, elija 
[Barra de herramientas] > [Mode] > [Accesorio] 
> [Grabación de pantalla]. Puede utilizar 
Grabación de pantalla para guardar como un 
archivo de película el contenido de una reunión 
realizada en StarBoard. Para obtener más 
información, consulte la ayuda en línea.
19 Chapter 5  Funciones útiles en StarBoard Software
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